PYTHON IDE

THE INTELLIGENT DEVELOPMENT ENVIRONMENT for PYTHON PROGRAMMERS

Wing Tutorial

This tutorial introduces Wing Personal by taking you through its feature set with a small coding example.
For a faster introduction, see the Quick Start Guide.

If you are new to programming, you may want to check out the book Python Programming Fundamentals
and accompanying screen casts, which use Wing 101 to teach programming with Python.

Our How-Tos show how to use Wing with 3rd party GUI toolkits, web development frameworks,
Python-based modeling, rendering & compositing systems, and other Python frameworks and toolkits.

To get started, press the Next (down arrow) icon in the toolbar immediately above this page: ‘I'

The screenshots in this tutorial were made with Wing Pro and may contain some tools that are not
available in Wing Personal. These can be ignored and will not be discussed in the text that follows.

Tutorial: Getting Started
To get started, you need to:
(1) Install Python and Wing

If you don't already have them on your system, install Python and Wing. For detailed instructions, see
Installing Wing.

(2) Start Wing

Wing can be started from a menu, desktop, or tray icon or using the command line executable. For
detailed instructions, see Running the IDE.

If you don't have a license, you can obtain a 30-day trial the first time you start Wing.

Once Wing is running, you should switch to using the Tut ori al listed in Wing's Hel p menu because it
contains links directly into the IDE's functionality (this includes step (3) below).

(3) Copy the Tutorial Directory

Next, copy the entire t ut ori al directory out of the top level of your Wing IDE installation to a location
where you will have write access to the files in it. You can do this manually or use the following link, which
will prompt you to select the target directory into which to copy the tutorial: Copy Tut ori al Now

Note

We welcome feedback, which can be submitted with Subnmi t Feedback in Wing's Hel p menu
or by emailing support at wingware.com


https://wingware.com/doc/howtos/quickstart
http://knuth.luther.edu/~leekent/IntroToComputing/
https://wingware.com/doc/howtos/index
https://python.org/download
https://wingware.com/downloads
https://wingware.com/doc/install/installing
https://wingware.com/doc/install/running-the-ide
mailto:support@wingware.com

To get to the next page in the tutorial, use the Next Page icon shown in the toolbar just above this text:

\

Tutorial: Getting Around Wing
Let's start with some basics that will help you get around Wing while working with this tutorial.

Wing's user interface is divided into an editor area and two toolboxes separated by draggable dividers. Try
pressing F1 and F2 now to show or hide the two toolboxes. Also try Shift-F2 to maximize the editor area
temporarily, hiding both tool areas and toolbar until Shift-F2 is pressed again.
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Tool and editor tabs can be dragged to rearrange the user interface, optionally creating a new split. Right
click on the tabs for a menu of additional options, such as adding or removing splits or to move the toolbox
from right to left. The number of splits shown by default in toolboxes will vary according to the size of your
monitor.

Notice that you can click on an already-active tool tab to minimize that tool area. Click again on any tab to
restore the toolbox to its previous size.

By default, the editor shows all open files in all splits, making it easy to work on different parts of a file
simultaneously. This can be changed by unchecking Show All Files in Al Splits in the
right-click context menu on the editor tabs.

! Splitting your editor area makes it easier to get around this tutorial. To do this now, right click on the

editor tab area and select Spl it Si de by Si de. On small monitors and laptops, it may be preferable to
create a new window for the tutorial by right clickihng on its tab and selected
Move Wng Help to New W ndow.



Context Menus

In general, right-clicking provides a menu for interacting with or configuring a part of the user interface.
The text that follows refers to these menus as "context menus".

Configuring the Keyboard

Use the Edi t > Keyboar d Personal ity menu or
User Interface > Keyboard > Personality preference to tell Wing to emulate another editor,
such as Visual Studio, VI/Vim, Emacs, Eclipse, or Brief.

v Wing IDE
VI/VIM
Ernacs
Brief
Visual Studic
Eclipse

v Enable Auto-Editing
Configure Auto-Editing...

Configure Tab Key...

The Configure Tab Key item in the Edit > Keyboard Personality menu or the
User Interface > Keyboard > Tab Key Action preference can be used to select among
available behaviors for the tab key. The default is to match the selected Keyboard Personality. When the
Keyboard Personality is set to Wing, the tab key acts differently according to context. For example, if lines
are selected, repeated presses of the tab key moves the lines among syntactically valid indent positions.
And, when the caret is at the end of a line, pressing the tab key adds one indent level.

Auto-Completion

There are many options for Wing's auto-completer. These are set in the Edi t or > Aut o- conpl eti on
preferences group. For example, if you are used to using the Ent er key for completion, you may wish to
add that now to the Edi t or > Aut o-conpl etion > Conpl eti on Keys preference.

Other Configuration Options

Wing's cross-platform GUI adjusts to the OS on which you are running it (except on Linux where it cannot
use the system-provided UI). You can set the colors used in the editor with the
User Interface > Editor Col or Pal ette preference. To apply this palette also to the rest of the
Ul (outside of editors), enable the Use Editor Pal ette Throughout the U preference.

To set a dark background display style select one of One Dar k, Moni kai , Bl ack Backgr ound, or
Sol arized - Dark asthe Editor Color Palette.
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The User Interface > Font s > Di spl ay Font/ Si ze and User
Interface > Fonts > Editor Font/Si ze preferences select fonts for the user interface and editor.

The size and type of tools used in the toolbar at the top of Wing's main window can be changed by right
clicking on one of the enabled tools.

For more information on adjusting the user interface to your needs, see the Customization chapter of the
manual.

Tutorial: Check your Python Integration

Before starting with some code, let's make sure that Wing has succeeded in finding your Python
installation. Bring up the Pyt hon Shel | tool now from the Tool s menu. If all goes well, it should start
up Python and show you the Python command prompt like this:


https://wingware.com/doc/custom/index

DebugProbe | Watch | Modules | PythonShell | Bookmarks | Messages | OS Commands |4/" %

Commands execute without debug. Use arrow keys for history, COptions

Python 3.3.2 (v3.3.2:d847928ae3f6, May 16 2813, 88:83:43) [MSC v.168@ 32 h:
Type "help"”, "copyright", "credits™ or "license™ for more information.
P
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If this is not working, or the wrong version of Python is being used, you can point Wing in the right
direction with the Pyt hon Execut abl e setting in Proj ect Properti es, available from the toolbar
and Pr oj ect menu.

An easy way to determine the path to use here is to start the Python you wish to use with Wing and type
the following at Python's >>> prompt:

i mport sys
sys. execut abl e

This can also be typed into the IDLE that is associated with your Python install, if IDLE is installed. On OS
X this is generally the easiest way to find the correct executable to use.

You will need to Restart Shell from Options in the Python Shell tool after altering Python
Executable.

Once the shell works, copy/paste or drag and drop these lines of Python code into it:

for i in range(0, 10):
print('*" * i)

This should print a triangle as follows:

#»» Tor i in range(2, 18):
print{'*" * i)
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Notice that the shell removes common leading white space when blocks of code are copied into it. This is
useful when trying out code from source files.
Now type something in the shell, such as:

i mport sys
sys. getrefcount (i)



Note that Wing offers auto-completion as you type and (in Wing Pro and Wing Personal) shows call
signature and documentation information in the Source Assistant. Use the Tab key to enter a
selected completion. Other keys can be set up as completing keys wusing the
Editor > Auto-conpletion > Conpl eti on Keys preference.

You can create as many instances of the Python Shell tool as you wish. Each one runs in its own private
process space that is kept totally separate from Wing and your debug process.

Tutorial: Set Up a Project

Now we're ready to get started with some coding. The first step in working with Wing is to set up a project
file so that Wing can find and analyze your source code and store your work across sessions.

If you haven't already copied the t ut ori al s directory from your Wing installation, please do so now as
described in Tutorial: Getting Started.

Wing starts up initially with the Default Project. Start by creating a new project for your work on this
tutorial, using Save Proj ect As inthe Project menu.Usetutorial.wpr asthe project file name
and place itinthe t ut ori al directory that you created earlier.

Next, use the Add Existing Directory item in the Project menu to add your copy of the
tutorial s directory. Leave the default options checked so that all files in that directory are added to the
project.
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To make it easier to work on source code and read this tutorial at the same time, you may want to
right-click on the editor tab area and select Spl it Si de by Si de.

Opening Files

Files in your project can be opened by double-clicking in the Pr oj ect tool, by typing fragments into the
Open From Proj ect dialog, and in other ways that will be described later.

Try the Open From Proj ect dialog now by using the key binding listed for it in the Fi | e menu. Type
ex as the file name fragment and use the arrow keys and then Ent er to open the file exanpl el. py.
Now try it again with the fragment sub ex. This matches only files with both sub and ex in their full path
names. In larger projects, Open From Proj ect is usually the easiest way to open a file.


https://wingware.com/doc/intro/tutorial-getting-started

Enter fragments separated by spaces:

exa| Options
exarmnpled.py

path_example.py

C:\Wsersimaintitutoriallexample 2. py

[Dpen SelectedJ [ Cancel

Transient, Sticky, and Locked Files

Wing opens files in one of several modes in order to keep more relevant files open, while auto-closing
others. To see this in action, right-click on os in i mport os at the top of exanpl el. py and select

Goto Definition. The file os. py will be opened non-sticky, so that it is automatically closed when
hidden.

The mode in which a file is opened is indicated with an icon in the top right of the editor area:
; - The file is sticky and will be kept open until it is closed by the user.

™ _ The file is non-sticky and will be kept open only while visible. When a non-sticky file is edited, it
immediately converts to sticky.

E - The file is locked in the editor, so that the editor will not be reused to display other newly opened
files. This mode is only available when multiple editor splits are present.

Clicking on the stick pin icon toggles between the available modes. Right-clicking on the icon displays a
menu of recently visited files. Note that this contains both non-sticky and sticky files, while the Recent
listin the Fi | e menu contains only sticky files.

& example2.py

&  examplel.py
= Wing IDE Help

Configure...
The number of non-sticky editors to keep open, in addition to those that are visible, is set with the
Edi tor > Advanced > Maxi num Non- Sti cky Editors preference.

This mechanism is also used in multi-file searches and other features that navigate through many files. In
general you can ignore the modes and Wing will keep open the files you are actually working on, while
auto-closing those that you have only visited briefly.

Tutorial: Setting Python Path

Whenever your Python source depends on PYTHONPATH, either set externally or by altering sys. pat h
at runtime, you will also need to tell Wing about your path.

This value can be entered in Pyt hon Pat h in the Proj ect Properties dialog, which is accessible
from the Pr oj ect menu and the toolbar:
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For this tutorial, you need to add the subdir sub-directory of your tutorials directory to
Pyt hon Path, as shown above. This directory contains a module used as part of the first coding
example.

Note that the full path to the directory subdi r is used. This is strongly recommended because it avoids
potential problems finding source code when the starting directory is ambiguous or changes over time. If
relative paths are needed to make a project work on different machines, use an environment variable like
${ W NG PRQIECT_DI R}/ subdi r. This is described in more detail in Environment Variable Expansion.

The configuration used here is for illustrative purposes only. You could run the example code without
altering PYTHONPATH by moving the pat h_exanpl e. py file to the same location as the example
scripts, or by placing it into your Python installation's site-packages directory, which is in the default
PYTHONPATH.

Python Path Hints

If your main entry point is Python code that alters sys.path, and the file is set as the
Main Entry Point in Project Properties then Wing can often determine the correct
PYTHONPATH to use without any changes to Pyt hon Pat h in Proj ect Properti es.

When in doubt, compare value of sys. path at runtime in your code with the value reported by
Show Pyt hon Envi ronnment inthe Source menu.


https://wingware.com/doc/proj/variable-expansion

Tutorial: Introduction to the Editor

Now that you have set up your project, Wing will have found and analyzed the tutorial examples, and all
the modules that are imported and used by them. This analysis process runs in the background and is
used for auto-completion, call tips, and other features. With larger code bases, you may notice the CPU
load from this process, and Wing will indicate that processing is active by displaying Anal yzi ng Fil es
in the status area at the bottom left of the main IDE window:

f Line 14 Col 16 - [Edit] {Analyzing Files: pass 1, Q=1368)

However, with this tutorial analysis will have happened instantaneously after the project was configured.
Editing with Wing

Let's start by trying out a subset of Wing's editor features, focusing on the auto-completer, Source
Assistant, and some of Wing's auto-editing operations.

Open the file exanpl el. py from the Project tool. Then bring up the Sour ce Assi st ant tool the Tools
menu or by clicking on its tab. This is where Wing shows documentation, call signature, and other
information as you move around in your source code or work with other tools.

Scroll down to the bottom of exanpl el. py and enter the following code by typing (not pasting) it into the
file:

news = Rea

Wing displays a context-sensitive auto-completer as you type. You can scroll around in the list with the
arrow keys, type Esc or Ct r| - G to abort completion, or Tab to enter the currently selected completion.

L you are used to wusing the Enter key for auto-completion, add it to the
Edi tor > Auto- Conpl etion > Conpl eti on Keys preference now.

When you first typed "news" this completer wasn't helpful because you had not yet defined news as a
symbol in your source. However, once you move on to type = Re, Wing displays another completion list
with ReadPyt honNews highlighted. Notice that the Source Assistant updates to show call information for
that function, or for whatever value is selected in the auto-completer:
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Next, press the Tab key to enter the completion of ReadPyt honNews and enter (. You should now
have the following code in your editor;

news = ReadPyt honNews(

Lt you are used to using the Ent er key for auto-completion, add it to the Conpl eti on Keys

preference now.

Now type Get to start entering arguments for your invocation of ReadPyt honNews. You will see the
Source Assistant alter its display to highlight the first argument in the call signature for ReadPyt honNews
and add information on the argument's completion value:
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The docstring for ReadPyt honNews is temporarily hidden to conserve screen space. This behavior can
be toggled with the Show docstring during conpl etion option in the Source Assistant's context
menu.

Now continue entering the rest of the source line so you have the following complete line of source code:
news = ReadPyt honNews( CetltentCount ())
To play around with the editor a bit more, enter the following additional lines of code:

Print AsText (news)
Pr onpt ToCont i nue()
Pri nt AsHTM_( news)

At this point you have a complete program that can be run in the debugger. Don't try it yet, however. It
contains some deliberate bugs and first we should take a look at some of Wing's code navigation features.

Tutorial: Navigating Code

As already noted, the Sour ce Assi st ant updates as you move your insertion caret around the editor,
or when browsing through the auto-completer. For example, try moving between the invocation of
Print AsText and the variable news in the code you just typed. The blue links in the Source
Assi st ant can be used to jump to the points of definition of each symbol listed there.



If you click on one of the links in the Sour ce Assi st ant, use the green back arrow at the top left of the
editor to return from the value or type definition:

4

The link after Synbol: goes to the point of definition of that variable, while any links after
Li kely Type: go to the point of definition of that data type. These are the same if the symbol is a
function, method, or class, but they differ for variables. For example, for news the point of definition is the
line where it is first assigned a value and the type is a Python list.

Python Documentation

For built-ins and code in the Python standard library, Wing tries to add links into the Python
documentation. For example, type open in the editor and try out the htt ps:// docs. pyt hon. org link.
The documentation will be opened in your default web browser.

Symbol: open

Likely type: builtin function open
def open(file, mode=T, buffering=_1, encoding=Mone, errors=MNone,
newline=MNone, closefd=True, opener=None)

Retumns: TextlOWrapper

http:{/docs.python.org/py3kilibrary/functions . htmi#open
open(file, mode=T, buffering=-1, encoding=MNone,

errors=Mone, newline=None, closefd=True, opener=MNone) -= file
object

Open file and return a stream. Raise |0Error upon failure.

Now use Undo or press the del et e key to remove open from your code.
Goto-Definition

A quicker way to visit the point of definition of a symbol is to click on it and press F4 or right click and use
one of the Got o Definition context menu items. Again, you can use the history back/forward arrows
at the top left of the editor to return from the point of definition.

Try this for Par seRDFNews in exanpl el. py. Wing will open up the file pat h_exanpl e. py and show
the point of definition of Par seRDFNews. Notice that the file is opened in non-sticky mode ™ and will
auto-close unless you toggle the stick pin icon to or edit the file.

Source Index

Wing maintains a set of source index menus at the top of the editor area. The menus are updated as you
move around code, and additional levels of menus are added as needed, based on context.

< |Anuﬁ1erclass v||_init_ v”nested_functiun?_ v| " w M

Try these now to navigate to CHandl er in pat h_exanpl e. py, and then use the second menu to
navigate to endEl enent .

Now use the history back arrow at top left of the editor area to return to the invocation of Par seRDFNews
in exanpl el. py. You will need to press the arrow several times to move back through your visit history.

Find Symbol



If you are looking for a symbol defined in the current scope, use Fi nd Synbol in the Source menu.
This displays a dialog where you can type a fragment matching the symbol name. Use the arrow keys to
traverse the matches and press Ent er to visit the symbol's point of definition.

Select Source Symbol
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There are many other editor features worth learning, but we'll get back to those later in this tutorial, after
we try out the debugger.

Tutorial: Debugging

The exanpl el. py program you have just created connects to python.org via HTTP, reads and
parses the Python-related news feed in RDF format, and then prints the most recent five items as text and
HTML. Don't worry if you are working offline. The script has canned data it will use when it cannot connect
to pyt hon. org.

To start debugging, set a breakpoint on the line that reads return 5 in the Get |t enCount function.
This can be done by clicking on the line and selecting the Br eak toolbar item, or by clicking on the
left-most margin to the left of the line. The breakpoint should appear as a filled red circle:
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= def run():
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print("Done")
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Next start the debugger with the green arrow icon in the toolbar or the St art/ Conti nue item in the
Debug menu. Wing will show the Debug Pr operti es dialog with the properties that will be used during
the debug run. Just ignore this for now, uncheck the Show this dialog before each run
checkbox at the bottom, and press OK.

Wing will run to the breakpoint and stop, placing a red indicator on the line. Notice that the toolbar
changes to include additional debug tools, as shown below:

Y > 21 m ¢ ¥ W & E=

Break Debug DebugTo Cursor Stop Restart Pause  StepInto  Step Over StepOut  UpStack  Show Position  Down Stack

Your display may vary depending on the size of your screen or if you have altered the toolbar's
configuration. Wing displays tooltips explaining what the tools do when you mouse over them.

Now you can inspect the program state at that point with the St ack Dat a tool and by going up and
down the stack from the toolbar or Debug menu. The stack can also be viewed as a list using the
Call Stack tool.

Notice that the Debug status indicator in the lower left of Wing's main window changes color depending on
the state of the debug process. Mouse over the indicator to see detailed status in a tooltip:



Stack Data |Debug Probe |Python Shell|Messages |Mercurial | Subversion
main.py (pid 6576) (paused) ~  _GetlLatestVersions(): site_session.py, line 1561 v
Variable Value -

¥ locals {'self': <website.site session.CASession instance at Oxb7695 ... {1
product_group ‘wingpro'
¥ self <website.site_session.CASession instance at Oxb769528c>
> dict__ {'_CSession__fFail': 0, '_CASession__fDBH": None, 'fArgs": { ... (trun
_doc__ None
_doc_ <0xb76e5820L> " Generic HTML session manager class. Your application subcl...

__module__ ‘website.site_session'
__module__ <0xb76e3a20L> ‘'session’
__sessionid__ ‘COMwvyujlsnOrkklA®
locale ‘en’
¥ globals {'CTBody": <class htm|.CTBody at 0x94113bc:, 'CParagraph’: < ..
> builtins__ <dict Oxb76f7b54L; len=142>
_doc__ ' site_session.py -- Session manager for the wingware web ...
_ file_ ‘/home/sdeibel fwingware /website3 /cgi/website/site_session.py’
_ pame__ ‘website.site_session’ -
»

Next, try stepping out to the enclosing call to ReadPyt honNews. In this particular context, you can
achieve this in a single click with the Step Qut toolbar icon or Debug menu item. Two clicks on
Step Over also work. ReadPyt honNews is a good function to step through in order to try out the basic
debugger features covered above.

8.1. Tutorial: Debug I/O

Before continuing any further in the debugger, bring up the Debug 1/ O tool so you can watch the
subsequent output from the program. This is also where keyboard input takes place in debug code that
requests for it.

Once you step over the line Pri nt AsText (news) you should see output appear as follows:

Debug 1/O | Debug Probe | Watch | Modules | Python Shell I Bookmarks | Mezsages | os Curﬂ;ﬁv

Debug IO (stdin, stdout, stderr) appears below Options

Mon, 15 Oct 2887 28:45 -8488 -- PyCon 2885: Call for Talk & Tutorial Proposals (hti
Tue, 11 Sep 2887 5:58 -8688 -- Texas Regilonal Python Uncenference in Houston This |
Fri, 31 Aug 28687 12:88 -8588 -- Python 3880 released as Python 3.8al (http://wew. py
Sat, 25 Aug 28687 12:18 -8588 -- Coming scon: Pylleek #5 - Python Game Programming Ch
Thu, 23 Aug 20087 16:1@ +828@ -- New Python Bugtracker (http://www.python.org/news/:

For code that tries to read from st di n or uses i nput (or in Python 2.x raw_i nput ), the Debug 1/ 0O
tool is where you would type your input to your program. Try this now by stepping over the
Pr onpt ToCont i nue call. You will see the prompt "Press Enter to Continue" appear in the Debug 1/ 0O
tool and the debugger will not complete the St ep Over operation until you press Enter while focus is in
the Debug 1/ O tool.

Note that you can also configure Wing to use an external console from the Opti ons menu in the
Debug 1/ O tool. This is useful for code that depends on details of the Debug |/ O environment (such as
cursor control with special output characters).

8.2. Tutorial: Debug Process Exception Reporting

Wing's debugger reports any exceptions that would be printed when running the code outside of the
debugger.

Try this out by continuing execution of the debug process with the Debug toolbar item or
Start / Continue iteminthe Debug menu.



Wing will stop on an incorrect line of code in Pri nt ASHTML and will report the error in the Except i ons
tool:

testdebug.py (/Users/sdeibel/Desktop): Default Project: Wing

l’H“éllllé E,BI- O »

- | testdebug.py :| [ run s Fow % E

= def run(): =)

] print("Hello everyone") el
X =Yy

print("Done")

-

[Breakpoints| Exceptions [Search|Stack Data|Testing|Subversion|Search in Fili< » ¥

| _main__.py (pid 20617) : | (lgnore this exception locat &= &= Options 7.

in _LogErrorReplacement
lastResort.handle(record)
File "/Users/sdeibel/py343/lib/python3.4/site-packages/IPython/core/
interactiveshell.py", line 2881, in run_code
exec(code_obj, self.user_global_ns, self.user_ns)
File "<ipython-input-2=", line 2, in <module>
File " /Users/sdeibel /Desktop/testdebug.py”, line 3, in run
X =yy

< 4 ractoring|PyLint|Source Browser|Snippets

builtins.NameError: name 'yy' is not defined
¥ Line 5 Col 0 - [User]

Notice that this tool highlights the current stack frame and that you can click on frames to navigate the
exception backtrace. Whenever you are stopped on an exception, the Debugger Status indicator in the
lower left of Wing's main window turns red.

Advanced Options

Wing Pro and Wing Personal's debugger provides several exception handling modes, which differ in how
they determine which exceptions should be reported. It is also possible to add specific exception types to
always report or never report. This is described in more detail in Managing Exceptions. Most users will not
need to alter these options, but being aware of them is useful.

8.3. Tutorial: Execution Environment

In this tutorial we've been running code in the default environment and with the default Python interpreter.
In a real project you may want to specify one or more of the following:

* Python interpreter and version
* PYTHONPATH

» Environment variables

* Initial run directory

* Options sent to Python

* Command line arguments


https://wingware.com/doc/debug/managing-exceptions

Wing lets you set these for your project as a whole and for specific files.
Project Properties

The Envi ronnent and Debug/ Execut e tabs in the Proj ect Properties dialog, accessed from
the Proj ect menu, can be used to select the Python interpreter that is being used, the effective
PYTHONPATH, the values of environment variables, the initial directory for the debug process, and any
options passed to Python itself.

In most cases, Proj ect Properties is where you will make changes to the runtime environment for
all the project code that you execute and debug.

Try this out now by adding an environment variable TESTPRQJIECT=1 to the Environent in
Project Properties. Then restart debugging and look at os. environ to confirm that the new
environment variable is defined.

File Properties (and Launch Configurations)

File Properties are used to configure the command line arguments sent to a file when it is executed
or debugged, and (optionally) to override the project-defined environment.

The File Properties dialog is accessed from the Current File Properties item in the
Sour ce menu or by right-clicking on a file in the editor or Pr oj ect tool and selecting Pr operti es.

[l File Properties: examplel.py T -]

| File Attributes | Editor | Debug/Execute | Testing |

Ervironment IUSE Project Settings and Run Args: - I @

| test args|

Show this dialog before each run

W [ W OK ]IxCanr_EII

The most common use of Fi | e Properties is simply to set the command line arguments to use with a
file. Try this now by bringing up Fi |l e Properties for exanpl el. py and set the run arguments in the
Debug/ Execut e tabtotest args.

Now if you restart debugging and type the following in the Debug Probe you will see that the
environment and arguments have been set:

0s. envi ron. get (' TESTPRQIECT" )
sys.argv[1:]

The output should be:

1
["test', "args']

To also override the project-defined environment for a particular file, define a Launch Confi gurati on
and selectitin Fil e Properti es. Launch configurations set up an environment like that which can be
specified in Proj ect Properti es, paired with a particular set of command line arguments.

Try this now by bringing up File Properties for exanplel.py again and selecting
Use Sel ected Launch Configuration for Envi ronnent under the Debug/ Execut e tab. Press



the New button that appear, use™ My Launch Config™™ as the name for the new launch configuration, and
press OK. Wing will show the properties dialog for the new launch configuration.

Next enter run arguments ot her args and change the Envi ronnent to Add to Project Val ues
and enter TESTFI LE=2 and TESTPROQJECT=. This adds environment variable TESTFI LE and removes
the TESTPRQIECT from the inherited project-defined environment.

Now restart debugging again and enter this in the Debug Pr obe:

0s. environ. get (' TESTPRQIECT' )
0s. environ. get (' TESTFI LE' )
sys.argv[ 1:]

The output should be:

None
2
["other', "args']

Main Debug File

You can specify one file in your project as the main entry point for debugging. When this is set, debugging
will always start there unless you use Debug Current Fil e inthe Debug menu.

To set a main debug file use Set Current as Main Debug File inthe Debug menu, right click on
the Proj ect tool and select Set as Main Debug Fil e, or use the Mai n Debug Fil e property in
the Debug tab of the Proj ect Properties dialog.

Try this now by setting exanpl el. py as the main debug file. Now it is no longer necessary to bring
exanpl el. py to frontin order to start debugging it.

Whether or not you set a main debug file depends on the nature of your project.
Named Entry Points

In some projects it is more convenient to define multiple entry points for executing and debugging code.
To accomplish this, Naned Entry Poi nts can be set up from the Debug menu. Each named entry
point binds an environment, either specified in the project or in a launch configuration, to a particular file.
Once defined, they can be assigned a key binding or accessed from the Debug Naned Entry Poi nt
and Execut e Naned Entry Poi nt itemsinthe Debug menu.

Named Entry Points are a good way to launch a single file with different arguments or environment.

8.4. Tutorial: Debugging from the Python Shell

In addition to launching code to debug from Wing's menu bar and Debug menu, it is also possible to
debug code that is entered into the Pyt hon Shel | (and in Wing Pro the Debug Pr obe).

Enable this now by clicking on the bug icon in the top right of the Pyt hon Shel | . Once this is done, the
status message at the top of the Python Shel | should change to include
Commands wi |l be debugged and an extra margin is shown in which you can set breakpoints. Wing
will reach those breakpoints, as well as any breakpoints in editors for code that is invoked. Any exceptions
will also be reported in the debugger.

Let's try this out. Paste the following into the Pyt hon Shel | and press Ent er so that you are returned
to the >>> prompt:

def test function():
x = 10
print (x)
X += 5



y = 20
print (x+y)

Then place a breakpoint on the line that reads pri nt (x) by clicking in the breakpoint margin at the left
of the line text and prompt.

Next type this into the Pyt hon Shel | and press Ent er:
test_function()
Wing should reach the breakpoint on the pri nt (x) line.

You can now work with the debugger in the same way that you would if you have launched code from the
toolbar or Debug menu. Try stepping and viewing the values of x and y as they change, either in the
St ack Dat a tool or by hovering the mouse over the variable names.

Take a look at the stack in the Cal | Stack or Stack Data tool to see how stack frames that occur
withing the Pyt hon Shel | are listed. You can move up and down the stack just as you would if your
stack frames were in an editor.

Notice that if you step off the end of the call, you will return to the shell prompt. If you press the red St op
button in the toolbar or select St op Debuggi ng from the Debug menu, Wing will complete execution of
the code without debug and return you to the >>> prompt. Note that the code is still executed to
completion in this case becaused there is no way to simply abandon a number of stack frames in the
Python interpreter.

8.5. Tutorial: Debugging Code Not Launched by the IDE

So far we've been debugging code launched from inside of Wing. Wing can also debug processes that are
running within a web framework, as scripts in a larger application, or that get launched from the command
line. These are cases where a debug process cannot be launched from the IDE, so another method is
needed to initiate debug.

Let's try this now with exanpl e2. py in your tutorial directory. First, copy wi ngdbst ub. py out of install
directory listed in Wing's About box. Place this in the same directory as exanpl e2. py. Next, click on
the bug icon in the lower left of Wing's main window and select Accept Debug Connecti ons. Then set
a breakpoint on lines 10 and 22 of exanpl e2. py:



ey e ==

File Edit Scurce Refactor Project Debug  Testing  Tools  Window  Help

1 E - -
v xa@al <~ D=
example2.py Help
< F v X

print{"This code runs outside of the debugger™) -

1]
™
5
I
3

# A breakpoint on the following line will not be reached
P ® = "test value"

print{"Now starting the debugger and attaching to the IDE™)
import wingdbstub

m

= jif '"WINGDE_ACTIVE' in os.environ:
print("5uccess starting debug")
= else:
print("Failed to start debug... continuing without debug")

# Set a breakpoint on the following line; it should be reached
# if debugging started successfully
® printx

print{"Done™}

-

-ii’ Source Assistant | Source Browser | Snippets | Project |

| Search in Files | Search | Stack Data | Exceptions | Breakpaints | Testing | Debug If0 I tﬂhv
3 Line 26 Col 0 - [User]

If you are working on OS X, using the Windows zi p install, or using the Linux t ar install of Wing, you
will need to edit wi ngdbst ub. py to set W NGHOVE to the full path to the Wing installation directory (on
OS X, this is the name of Wing's . app directory). This is done automatically by the regular Windows
installer and Debian and RPM installs on Linux. If you are using one of those you can skip this step.

Now we're ready to debug exanpl e2. py when it is launched from outside of the IDE. To launch it, use
the DOS Command prompt on Windows, a bash or similar command prompt on Linux, or Terminal or an
xterm on OS X by typing:

pyt hon exanpl e2. py

You may need to specify the full path to python if it is not on your path.

This should start up the code, print some messages, connect to the IDE, and stop on the breakpoint on
line 22. Read through the code and the messages printed to understand what is happening. You can
verify that the debugger attached by looking at the color of the bug icon in the lower left of the IDE
window, and by hovering the mouse over it:

¥ Line 26 Col 0 - [User]

l Debugger: Debug process paused; pid=3904 [0 modules loaded] '

Once you are stopped at a breakpoint or exception in externally launched code, the debugger works just
as it would had you launched the debug process from the IDE. The only difference is that the environment
is set up by the process itself and the settings specified in Project Properties and
File Properties arenotused.




When you continue the debugger from the toolbar or Debug menu, the program should print the value of
X and exit.

This is a very simple example to illustrate how externally launched code can be debugged. The import of
wi ngdbst ub can also be placed in functions or methods, and there is a debugging API that provides
control over starting and stopping debugging.

See Debugging Externally Launched Code for details and the How-To guides for information on setting
this up with specific web frameworks, compositing and rendering tools, and other applications.

Remote Debugging

Using the same mechanism, but with some additional configuration, it is also possible to debug Python
code launched on another machine. This is documented in Manually Configured Remote Debugging in the
Wing manual.

Tutorial: Indentation Features

Since indentation is syntactically significant in Python, Wing provides a number of features to make
working with indentation easier.

Auto-Indentation

By now you will have noticed that Wing auto-indents lines as you type, according to context. This can be
disabled with the Aut o- | ndent preference.

Wing also adjusts the indentation of blocks of code that are pasted into the editor. If the indentation
change is not what you wanted, a single Undo removes the indentation adjustment, if there was one.

Block Indentation

In Wing's default keyboard personality, the Tab key is defined to indent the current line or blocks of lines,
rather then entering a tab character (which can be done with Ctrl - T). As noted earlier, the Tab Key
Act i on preference can be used to customize how the tab key behaves.

One or more selected lines can be increased or reduced in indentation, or adjusted to match indentation
according to context, from the Indentation toolbar group:

=> Ze e
Indent Dedent Match Indent

Repeated presses of the Mat ch | ndent tool will move the selected lines among the possible correct
indent levels for that context.

These indentation features are also available in the Sour ce menu, where their key bindings are listed.
Converting Indentation Styles

In Wing Pro and Wing Personal, the | ndent at i on tool can be used to analyze and convert the style of
indentation found in source files. See Indentation Manager for details.

Folding

Unless the feature is disabled with the Enabl e Fol di ng preference, Wing Pro and Wing Personal can
fold editor code by indentation levels to hide areas that are not currently of interest or as a way to see a
quick summary of the contents of a source file.

The folding operations are enumerated in the Fol di ng sub-menu of the Sour ce menu and in the fold
margin context menu.

Folding acts in such a way that selecting across a fold and copying will copy the text, including its hidden
portions. Take a look at the Fol di ng sub-menu in the Sour ce menu and refer to Folding for details.


https://wingware.com/doc/debug/debugger-api
https://wingware.com/doc/debug/debugging-externally-launched-code
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https://wingware.com/doc/debug/manual-remote-debugging
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Tutorial: Other Editor Features

There are a number of other editor features that are worth knowing about:
Goto-Line

Navigate quickly to a numbered source line with the Got o Li ne item in the Edi t menu, or with the key
binding displayed there. In some keyboard personalities, the line number is typed into the data entry area
that appears at the bottom of the window. Press Ent er to complete the action.

In Wing Pro and Wing Personal, line humbers can be shown in the editor with the Show Li ne Numbers
item in the Edi t menu.

Selecting Code

Wing supports character, line, and block mode selection from the Sel ecti on Mbde item in the Edi t
menu.

In Wing Pro and Wing Personal, multiple selections can be made at the same time with the
BEdit > Miltiple Selections menu item, multiple selections toolbar item, and by pressing
Crl+Alt (or Command+Al't on the Mac) while making a selection with the mouse. Once there are
multiple selections, edits made will be applied in the same way to all the selections concurrently.

In Python code, the Sel ect sub-menu in the Edit menu can be used to easily select and traverse
logical blocks of code. The Sel ect Mire and Sel ect Less operations are particularly useful when
preparing to type over or copy/paste ranges of text. Try these out now on url | i b in ReadPyt honNews
in exanpl el. py. Each repeated press of Ctrl-Up will select more code in logical units. Press
Ctrl - Down to select less code.

The other operations in the Sel ect sub-menu can be used for selecting and moving forward or
backward over whole statements, blocks, or scopes. If you plan to use these and your selected
User Interface > Keyboard > Keyboard Personal ity preference does not support them, then
you will want to define key bindings for them using the User Interface > Keyboard > Custom
Key Bi ndi ngs preference. The command names are sel ect - x, next - x, and pr evi ous- x where x
is either st at ement , bl ock, or scope.

Line Editing

In Wing Pro and Wing Personal, lines can quickly be inserted, deleted, duplicated, swapped, or moved up
or down with the operations in the Li ne Editi ng sub-menu of the Source menu. If your keyboard
personality does not support them, then you can define key bindings for those you are interested in using.
The command names are: new-line-before, newline-after, duplicate-I|ine-above,
duplicate-Iline, move-1line-up,nove-Iline-down, del ete-I1ine,andswap-Iines.

Block Commenting

Lines of code can be commented out or un-commented quickly from the Sour ce menu . In Python code,
the Bl ock Conmenti ng Styl e preference controls the type of commenting that is used. The default is
to use indented single # characters since this works better with some of Wing's other features.

Brace Matching

Wing highlights brace matching as you type unless disabled from the Aut o Brace WNMatch preference.
The Mat ch Braces item in the Sour ce menu causes Wing to select all the code that is contained in
the nearest matching braces found from the current insertion point on the editor. Repeated invocations of
the command will traverse outward or forward in the file.

Text Reformatting

Code can be re-wrapped to the configured Ref ormatti ng Wap Col um with the Justify Rewr ap
item in the Sour ce menu. This will limit wrapping to a single logical line of code, so it can be used to
reformat an argument list or long list or tuple without altering surrounding code.



Tutorial: Searching

Wing provides several different interfaces for searching your code. Which you use depends on your task.

Toolbar Search

A quick way to search through the current editor is to enter your search string in the area provided in the
toolbar:

Getltem| Q, Search

If you enter only lower case the search will be case-insensitive. Entering one or more upper-case letter
causes the search to become case-sensitive.

Try this now in exanpl el. py: Type Getltem in the toolbar search area and Wing will immediately,
starting with the first letter typed, search for matching text in the editor. Press the Ent er key to move on
to the next match, wrapping around to the top of the file if necessary.

Toolbar-based searches always go forward (downward) in the file from the current cursor position.

Keyboard-driven Search

If you prefer a more powerful search interface using the keyboard only, try the key bindings for the items
in the M ni - search sub-menu of the Edit menu (the bindings vary by keyboard personality). From
here, you can initiate searching forward and backward in the current editor, optionally using the current
selection in the editor as the search string or using regular expression matching. You can also initiate
replace operations.

Try this in the exanpl el. py file: If using the default editor mode, press the Ct r | - U. For others, refer to
the M ni - sear ch group inthe Edit menu.

This will display an entry area at the bottom of the IDE window and will place focus there:
¥ Line 17 Cols 4-7 - [User] Search: Get

Continue by typing G, then e, then t. Notice how Wing searches incrementally with each keypress. This
lets you type only as much as you need to find the source code you are looking for.

While the mini-search area is still active, try pressing the same key combination you used to display it
again and Wing will search for the next matching occurrence. Note that if no match is found
Fai | ed Search will be displayed. However, pressing the mini search key combination again will wrap
around and start searching again at the top of the file, if there are any matches.

As in toolbar search, typing lower case letters results in case-insensitive search, and using one or more
upper case letters results in case-sensitive search.

Search direction can be changed during searching by pressing the key bindings assigned to forward and
backward mini-search. You can exit from the search by pressing the Esc keyorCrl -G

The regular expression based search options found in the M ni - sear ch menu group work similarly but
expect regular expressions for the search criteria (see below).

Keyboard-driven mini-replace works similarly, except that you will be presented with two entry areas, one
for your search string and one for the replace string. Use Quer y/ Repl ace to be prompted for Y and N
for each replace location, and Repl ace String to replace all matches globally in the file.

Wing adjusts some details of how mini-search behaves according to keyboard personality. For example,
in emacs mode Ct r| - G will cancel the search and in vi mode the search is always case sensitive, as in
VI/VIM.



Search Tool

The Search tool provides a familiar GUI-based search and replace tool for operating on the current
editor. Key bindings for operations on this tool are given in the Search and Repl ace group in the
Edit menu.

Search in Files Search | Stack Data I Exceptions I Breakpoints I*'v

Search: Getltem| -
| Case sensitive [ | Whole words [ In Selection
I 4 Previous I I ¥ Next I Wrapped Search Successful Options

Searches may span the whole file or be constrained to the current selection, can be case sensitive or
insensitive, and may optionally be constrained to matching only whole words.

By default, searching is incremental while you type your search string. To disable this, uncheck
I ncrenental inthe Options menu.

Replacing

When the Show Repl ace item in Opti ons is activated, Wing will show an area for entering a replace
string and add Repl ace and Repl ace All buttons to the Search tool:

Search in Files Search | Stack Data I Exceptions | Breakpoints I’-'v
Search:  PrintAs -
Replace: QutputAg| h
7] case sensitive [ Whole words [ In Selection
I‘I‘ F‘reviuu] I ! Nextl I Replace J l%eplace .ﬁ.ll] Search Succes  Options

Try replacing exanpl el. py with search string Pri nt As and replace string Qut put As.

Select the first result match and then Repl ace repeatedly. One search match will be replaced at a time.
Search will occur again after each replace automatically unless you turn off the Fi nd After Repl ace
option. Changes can be undone in the editor, one at a time. Do this now to avoid saving this replace
operation.

Next, try Repl ace All instead. Wing will simply replace all occurrences in the file at the same time.
When this is done, a single undo in the editor will cancel the entire replace operation.

Wildcard Searching

By default, Wing searches for straight text matches on the strings you type. In Wing Pro and Wing
Personal, wildcard and regular expression searching are also available in the Opt i ons menu.

The easier one of these to learn is wildcard searching, which allows you to specify a search string that
contains * to match anything, ? to match a single character, or ranges of characters specified within [
and] to match any of the specified characters. This is the same syntax supported by the Python gl ob
module and is described in more detail in the Wildcard Search Syntax manual page.

Try a wildcard search now by selecting Wld Card from the Options menu and making sure
exanpl el. py is your current editor. Set the search string to Pri nt As* (. This should display match all
occurrences of the string Pr i nt As, followed by zero or more characters, followed by (:

Search in Files Search | Stadk Data I Exceptions | Ereakpoints I*-'v

Search: Printas™] -
7] Case sensitive [] whole words [ In Selection
I %+ Preuiuus] I ¥ Mext I Search Successful Options
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Also try searching on Print As*[ A-Z] ( with the Case Sensitive search option turned on. This
matches all strings starting with Pri nt As followed by zero or more characters, followed by any capital
letter from A to Z, followed by (.

Finally, try Pri nt AsT???, which will match any string starting with Pri nt AsT followed by any three
characters.

Regular Expression Search

In Wing Pro and Wing Personal, regular expressions can also be used for searching. These are most
useful for complicated search tasks, such as finding all calls to a particular function that occur as part of
an assignment statement.

For example, open\ (newscache( )?,.*\) matches only calls to the function open where the first
argument is named newscache and there are at least two parameters. If you try this with exanpl el. py,
you should get exactly one search match:

2 examplel.py: tutorial.w C=m=n X

File Edit Source Refactor Project Debug Testing Tools Window Help
R ™ B
v X < -

example 1.py | example2.py I Help |

4 [F‘.eadPymunNews v] f w X

b if txt is Nome: -
= try:
svc = urllib.urlopen("http://www.python.org/channews. rdf")
twt = svc.read()
sve.close()
ot except:
return kCannedData
T = cpen(newscache, 'w')
fowrite(txt)
f.close()

|

1 *| Refactaring | ses | Source Broy

= if len(txt) == @:
return []

1| 1] | F

Search in Files Search | Stack Data | Exceptions I Breakpoints I Testing | Debug IO | D‘lsﬂ‘uv

Search: open'{newscache( )7,. =V -
[7] case sensitive [] whole words [ In Selection
[ + Preuiuus] [ J Hext ] Wrapped Search Successful Regex Flags Options

4 | callstack | Source Assistant |

¥ Line 42 Cols 8-28 - [User]

In this mode, the replace string can reference regex match groups with m, m, etc, as in the Python
re.sub() call

The details of regular expression syntax and usage can be very complicated, so this tutorial does not
cover them. For that, see the Regular Expression Syntax documentation in the Python manual.


https://docs.python.org/library/re.html

Search in Files Tool

The Search in Files tool in Wing Pro and Wing Personal is the most powerful search option
available in Wing. It supports multi-file batch search of the disk, project, open editors, or other sets of files.
It can also search using wildcards and can do regular expression based search/replace.

IEr-

File Edit Source Refactor Project Debug Testing Tocls Window  Help
9 R & B - —-—
Eweu X = &~ D> Ze

»
W

| example1.py | example 2. py | Help | 5
[¥5 ]
< | PrintAsText - £ v X
E R e e e e R R -
= def PrintAsText(news):
= for date, event, url in news:

print("#%s -- ¥s (¥s5)" ¥ (date, event, url))

Refactoring

Fm o m o
= def PrintAsHTML{news):
= for date, event, url im news: |;|
# NOTE: The line below contains a deliberate typo E Il
print{'<pr<iz¥s</i> <a href="¥s":>¥s</ax</p>" ¥ (date, url, event))
e
1 | ] b £ |
. B
Search in Files | Search | Stadk Data | Exceptions | Breakpoints | Testing | Debug IjO | Deblid ™ |2
2
Lock in:  Current File E}:ilter: All Source Files - 2
[¥5]
Search: PrintAs -

# Previous E ! Mext ; Pause File: example 1.py Options

examplel.py, line 59: def PrintAsHTML(news): M
examplel.py. line 70: PrintAsText(news) s

| »
125 stack

¥ Line 54 Cols 4-11 - [User]

Before worrying about the details, try a simple batch search on the exanpl el.py file. Select
Current File fromthe Look in selector onthe Search in Fil es tool. Then enter Pri nt As into
the search area.

Wing will start searching immediately, restarting the search whenever you alter the search string or make
other changes that affect the result set. When you are done, you should see results like those shown in
the screen shot above. Click on the first result line to select it. This will also display exanpl el. py with
the corresponding search match highlighted.

You can use the forward/backward arrows in the Search in Files tool to traverse your results.

File Filters

Next, change the Look in selectorto All Files in Project and change your search string to
HTM.. This works the same way as searching a single file, but lists the results for all files in your project.
You can also search all currently open files in this way.

In many cases, searching is more useful if constrained to a subset of files in your projects such as only
Python files. This can be done with by selecting Pyt hon Fil es inthe Filter selector. You can also
define your own file filters using the Create/ Edit Filters... iteminthe Filter selector. This will
displaythe Files > File Types > File Filters preference:



Marme Specification

All Source Files : Wild Card on File Mare: *.pyo; Wild Card on File Name: *Spy.class; Wild Card .
C/C++ Files Mime Type: text/x-c-source; Mime Type: text/x-cpp-source: Wild Card on Diredl
HTML and XML Files Mime Type: text/html; Mime Type: text/xml; Mime Type: text/x-zope-pt: Wild &
Hidden & Temporary Files Wild Card on File Marme: * pyo; Wild Card on File Name: *Spy.class; Wild Card ...
Python Files Mime Type: text/x-cython; Mime Type: text/x-python: Wild Card on Directory M

| Insert Remove Edit

File Filters

Each file filter has a name and a list of include and exclude specifications. Each of these specifications
can be applied to the file name, directory name, or the file's MIME type. A simple example would be to
specify *. pas wildcard for matching Pascal files by name, or using the t ext/ html  mime type for all
HTML files.

Searching Disk

Wing can also search directly on disk. Try this by typing a directory path in the Look i n area. Assuming
you haven't changed the search string, this should search for HTML in all text files in that directory.

Disk search can be recursive, in which case Wing searches all sub-directories as well. This is done by
selecting a directory in the Look i n scope selector and checking Recursi ve Directory Search in
the Opti ons menu.

You can alter the format of the result list with the Show Li ne Numbers item and Result File Nane
group in the Opt i ons menu, which contains several other search options as well.

Note that searching Proj ect Fil es is usually faster than searching a directory structure because the
set of files is precomputed and thus the search only needs to look in the files and not spend time
discovering them.

Multi-File Replace

When working with multiple files in the result set, Wing opens each changed file into an editor, whether or
not it is already open. This allows you to undo changes by not saving files or by issuing Undo within each
editor.

If you check Repl ace Operates on Di sk inthe Opti ons menu within the Search in Files tool,
Wing will change files directly on disk instead of opening editors into the IDE. This can be much faster but
is not recommended unless you have a revision control system that can get you out of hot water if
mistakes are made.

Note that even when operating directly on disk, Wing will replace changes in already-open editors only
within the IDE. This avoids creating two versions of a file if there are already edits in the IDE's copy. We
recommend selecting Save All from the file menu immediately after each replace operation. This
avoids losing parts of a replace, resulting in inconsistent application of a replace operation to the files in
your source base.

Tutorial: Other IDE Features

By now you have seen many of the IDE's features. Before we call it a day, let's look at a few other major
features that are worth knowing about.

PyLint Integration

Wing's PyLi nt tool, available in the Tool s menu, provides a simple integration with the command line
code inspection tool pyl i nt. To use this, you need to download and install pyl i nt separately. Then
right-click on the PyLi nt tool in Wing to configure the integration. Use the Updat e items in the
right-click context menu on the PyLi nt tool to update the tool's contents for the current file or package.
Clicking on errors, warnings, and informational messages takes you to the source code that pyl i nt is

flagging.



Errors (9) | Warnings (134) | Info (264) | v

Lir ]
ﬁ Line Column Message
= 59 4 FO401: Unable to import 'wingdbstub'

297 2 FO401: Unable to import 'build_config'
1 2506 2 E0213: CWin32TracerBuild.log_exception_if_not_rel
L= 2510 8 E1102: CWin32TracerBuild.log_exception_if_not_rel
E 2858 16 E1101: CheckO5XDebugBuilds: Module 'subprocess
| 2863 11 E1101: CheckOSXDebugBuilds: Module 'subprocess
- 2941 9 E0602Z: _GetExtraDebuggerBinariesinfo: Undefined »
£ 2941 17 E0O602: GCetExtraDebuggerBinariesinfo: Undefined »
.E 4722 4 E1120: Main: Mo value passed for parameter 'zdir' i

Note that this screenshot was taken with User Interface > Editor Color Palette
pref erence set to " Linen color palette and with User I nterface >
Apply Editor Palette Throughout the U enabled (with non-native display style). Each of the
screenshots that follows uses a different display style.

OS Commands

The OGS Commands tool can be used to set up, execute, and interact with external commands, for
building, deployment, and other tasks. The Buil d Conmand field in the Debug/ Execute tab of
Project Properties can be used to configure and select one command to execute automatically
before any debug session begins.

Debug I/O | Debug Probe | Watch | Modules | PythonShell | Bookmarks = ©OSCommands | M (M| ¥
Jowing --verbose —-new srcfide-4.0.wpr ¢] @ == & [@ optons

Running... (285 lines)

wingide - 2813/87/18 15:13:36 - emitting python interp changed -
wingide - 2813/87/18 15:13:36 - interp version= 2.5.4

wingide - 2813/87/18 15:13:36 - PYTHOMNPATH [u'/Users/sdeibel/src/ide’', u'', u'/fusr/loc
wingide - 2013/87/1@ 15:13:36 - (repeated 2 times)

wingide - 2813/87/18 15:13:36 - interp version= 2.5.4

wingide - 2813/87/18 15:13:36 - PYTHONPATH [u'/Users/sdeibel/src/ide', u'', u'/fusr/loc
wingide - 2013/87/1@ 15:13:36 - (repeated 5 times)

wingide - 2813/87/18 15:13:36 - interp version= 2.5.4

wingide - 2813/87/18 15:13:36 - PYTHOMNPATH [u'/Users/sdeibel/src/ide', u'', u'/fusr/loc
wingide - 2@13/@7/18 15:13:36 - Debugger: Listening for back-connection

wingide - 20813/87/18 15:13:36 - popenE with ['/usr/local/bin/python2.5', '=u', u'/User
wingide - 2@13/87/1@ 15:13:36 - popenE done

wingide - 2813/87/1@ 15:13:37 - Debugger: No debug process / not listening Tor connect
wingide - 2@13/@7/18 15:13:39 - General: Skipping update check —- done too recently
wingide - 2013/87/1@ 15:13:39 - running cmd <CSvnStatusCmd args=['status'] locs=[file: ™

For details see OS Commands Tool.
Source Browser

Wing Pro and Wing Personal include a Sour ce Browser that can be used to inspect and navigate the
module and class structure of your source code.


https://wingware.com/doc/oscommands/index
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By default, the browser will display classes, methods, attributes, functions, and variables defined in the
currently displayed source editor. The popup menu at the top left of the source browser can be used to
alter the display to include all classes or all modules in the project. The Options menu in the top right
allows filtering by origin, accessibility, and type of source symbols. The Options menu also allows sorting
the view alphabetically, by type, or in the order that symbols occur in the source file.

Double clicking on items in the Source Browser opens them into an editor. When
Fol | ow Sel ecti on is enabled in the Opti ons menu, Wing also opens files that are single-clicked or
visited by keyboard navigation in the Sour ce Br owser . In this case, files are opened in non-sticky mode.

Notice that the Sour ce Assi stant tool is integrated with the Source Browser, and will update its
content as you move around the Sour ce Browser tree as it does for the editor, shells, and Pr oj ect
tool.

File Sets

Wing allows you to create named sets of files which you can open as a group or search with the
Search in Files tool. File sets can be created and opened from the Fil e Sets iteminthe File
menu, by selecting items and right-clicking in the Pr oj ect tool, by right-clicking in the Open Fil es
tool, and fromthe Fi | ter and Opti ons menusinthe Search in Files tool.



Note that the Open Fil es tool is also useful for closing particular files or closing all files except a
selected set.

File Operations

Files can be created, deleted, moved, and renamed from the Pr oj ect tool by right-clicking, dragging,
and clicking on names in the tree. Deleted files are moved to the system's trash or recycling bin. When
files are in a revision control system, Wing will also issue the necessary revision control commands to
create, delete, move, or rename the file.

Perspectives

Perspectives are a way to store and later revisit particular arrangements of the user interface. For
example, you may set up one set of visible tools to use when testing, another for working on
documentation, and still another for debugging.

Perspectives are accessed from the Tool s menu.

(o« NN Manage Perspectives
ag
| Shared | Style | Key Binding
tools-only
tools-only
tools-only
tools-only Shift-F4
tools-only Shift-F4

¢
¢
'y tools-only Shift-F3
"y tools-only

Right click on the list for editing operations

Show Docs... |Preferences... Close

Optionally, Wing can automatically switch perspectives whenever debugging starts or stops, so that the
user interface differs according to how the tools were left when last editing or debugging. This is done by
selecting Enabl e Aut o- Per specti ves inthe Tool s menu.

For more information see Perspectives.
Extending the IDE

Wing can be extended by writing Python scripts that call into the IDE's scripting API. This is useful for
adding everything from simple editor commands and debugger add-ons to new tools (although the latter is
for advanced users only; the PyLi nt tool mentioned above is an example of a tool implemented by a
script).

There is a collection of user-contributed scripts for Wing in the contributed materials area.

See also Scripting and Extending Wing.

Tutorial: Further Reading

Congratulations! You've finished the tutorial. As you work with Wing on your own software development
projects, the following resources may be useful:

» Wing Support Website which includes our mailing lists and other information for Wing users.

* Wing Reference Manual which documents the features in detail.


https://wingware.com/doc/custom/perspectives
http://bitbucket.org/sdeibel/wing-contrib
https://wingware.com/doc/scripting/index
https://wingware.com/support
https://wingware.com/doc/manual

» How-To Guides for information on using Wing with frameworks like Django, Plone, Google App
Engine, matplotlib, Autodesk Maya, NUKE, and others.


https://wingware.com/doc/howtos/index
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